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EE354 Spring 2012 Lab 1: Introduction to Lab Equipment

In this lab, you will be refreshed on how MATLAB and the lab hardware can be used to view both the time-domain and
frequency-domain version of signals.

Part 1: Theory

Before beginning any lab experiment, it is imperative to predict the results we should observe from the hardware. These
predictions give us a basis for determining: (a) whether the hardware is operating properly, and (b) how closely our
experimental results match our theoretical predictions.

In this experiment, we will be working with a 1.1 MHz sinusoid with a DC offset. Mathematically, our signal is described
by the following equation;

5,(t)=0.5c0s(27(1.1MHz)t)+0.25V

In Table 1 (on page 6), record the theoretical values for the waveform’s minimum, maximum, DC offset, amplitude, peak-
to-peak amplitude, period, and frequency. In the space below, sketch the time-domain and magnitude frequency spectrum
of this signal (remember, graphs have axes, labels, and titles).

Before proceeding, have the instructor check your work.

Instructor Verification:



Part 2: Simulation

First, we’re going to create and display a 1.0 MHz sinusoid using the following MATLAB commands.

» fs = 12€6; % "fs" is sampling frequency. “N” is the number of samples of the sinusoid
» N =8192; % "T" is time between samples.

» T = 1/fs; % "t" is the time vector

» t = (0:N-1)*T; % "f0" is the frequency (in Hz) of the sinusoid, 1.0 MHz

» f0 = 1.1e6; % "A" is the amplitude of the sinusoid, 0.5 Volts

»A=0.5; % "s1" is our signal vector (a 1.0 MHz sinusoid)

» s1 = A*cos(2*pi* f0*t) + 0.25;

Plot the sinusoidal signal as a function of time. When plotting the signal, the following plot options/commands may prove
useful:

plot(x,y, "k-","linewidth",2) These plot options produce lines of different colors/styles, as well as a
thicker line that’s easier to see.

axis([xmin xmax ymin ymax]) Sets the amount of the waveform that’s visible in the figure window so
that you don’t get a big blue (or black, in this case) blob. | suggest setting
xmax to 10 psec or less.

xlabel (" label (units)®) All figures should have meaningful axes labels and titles.
ylabel (" label (units)*®)
title("Title")

Printout a copy of your plot and turn it in with the completed lab.

Next, we need to display the spectrum of our signal. Frequency content of sampled signals on a computer are calculated
using the Fast Fourier Transform (FFT). In this class we’re not worried about the underlying operation of the FFT (that’s
reserved for EE432), and thus, we’re going to use the Matlab function periodogram to perform a spectral estimation and
display the magnitude spectrum of our signals. In later labs, we’ll explore other ways for generating the spectrum, but for
now, this is the easiest and simplest technique.

To generate the spectrum, run the Matlab command: periodogram(sl,[], "onesided” ,N,fs);
Your output should look like the figure below:
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Figure 1: Spectrum of a single 1.1 MHz sinusoidal signal




Note That: The periodogram spectral estimator provides a normalized power spectral density in dB units! We haven’t
talked about dB units yet, but don’t worry, we will soon! Also recall the time/frequency resolution properties of the
Discrete Fourier Transform (higher frequency resolution means a longer sampling time/larger number of samples, NOT a
higher sampling frequency). You can observe this yourself by reducing N to 32 points and re-running the code above.

Printout a copy of your plot and turn it in with the completed lab.

Before proceeding, have the instructor check your work.

Instructor Verification:

Part 3: Hardware Measurements of the Sinusoidal Signal via the Oscilloscope

The quick reference guide for the LeCroy Oscilloscope is posted on the main EE354 website. Before proceeding, download
a copy of the quick reference guide and open it in a new window to use as a reference for operating the oscilloscope.

1. Using one of the Agilent 33220A Function Generators, create a 1.1 MHz sinusoid with a peak voltage of 0.5V.
Take a few moments to become familiar with the front panel controls of the function generator. Learn how to
select waveshapes, amplitudes, and frequencies using the keypad and the control knob.

a. Press the Sine button

b. Toggle the Freq tab until the default frequency is displayed. Enter “1.1” on the keypad, and then press
the MHz tab.

c. Toset the amplitude, we have to enter either the RMS value of our signal or the peak-to-peak amplitude
of our signal. Toggle the Ampl tab until the default amplitude is displayed. Enter “1.0” on the keypad,
and then press the Vpp tab.

d. To set the DC offset, toggle the Offset tab until the default DC offset is displayed. Enter “0.25” on the
keypad, and then press the Vpc tab.

e. Press the Graph button and verify that the generator is producing a 1.1 MHz sinusoid with peak-to-peak
amplitude of 1.0 Volts, and 0.25 Volt DC offset.

f.  Press the Output button and ensure that it is lighted. Only when the Output button is lit will the signal
generator produce an output signal.

g. Using one of the BNC cables, connect the output of the signal generator to Channel 1 of the LeCroy
oscilloscope, as shown in the figure below.
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Figure 2: Agilent Signal Generator to LeCroy Scope Connection.

What is the maximum frequency and maximum amplitude sine wave that the function generator can produce?




2. Use the LeCroy scope to display the signal. Learn how to select channels to display, and how to get a good
display without using the “Autoscale” button (Autoscale does not do anything you cannot do manually, and there
is no guarantee you will get the display settings you need). Most of the information you need can be found in the
“Quick Reference Guide” posted on the course website.

a. Before beginning a measurement, it is always a good idea to return the instrument to its default
configuration. For the LeCroy scope, press File = Recall Setup - Recall Default.

b. The default configuration will bring up both Channel 1 and Channel 2. In this case, we do not need to
display Channel 2. Select the C2 Tab at the bottom left-hand corner of the screen, and then un-check the
“Trace On” box.

c. Next, we need to properly set the input impedance of the scope to match the output impedance of the
function generator (for reasons that will become clear in EE372); that is, since the function generator
output is 50 Q, set the scope input to have 50 QQ impedance vice 1 MQ. Select the C1 Tab at the bottom
left-hand corner of the screen, and then under the “Coupling” listbox, select “DC50Q”.

d. Next, use the horizontal and vertical control knobs to adjust the display to show several cycles of the
sinusoid. Reasonably good values are 200 mV/Div on the vertical scale and 500 ns/div on the horizontal
scale.

e. Use the OFFSET knob to move the waveform into the center of the scope screen. When completed, you
should have a display that looks similar to the following:
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Figure 3: LeCroy Oscilloscope screen when properly set up and configured for this lab.

A couple of things should be pointed out before we continue. First, the “C1” marker on the left-hand side of the screen
indicates the OV point of the scope. Because our waveform has a 0.25V DC offset, it is not centered on the marker. If you
switch the coupling to “AC1MQ”, you will notice that the waveform gets larger (a result of the impedance mismatch) and
is centered on OV (due to the scope blocking the DC offset). Note that this is not the correct representation of our
waveform! On the right-hand side of the screen, the arrow marker indicates the trigger level for the waveform. If you
adjust the LEVEL knob, you will adjust where the signal is triggered (it will respond by moving left and right on the
screen), and if you adjust the knob to a value too high or too low, the scope will no longer trigger, and the waveform will
“dance” on the screen.

Note: Every time you make a measurement using the oscilloscope, you must pay attention to how the input is coupled,
how the waveform is acquired, how the oscilloscope is triggered, and the sampling rate being used. If you do not, you
could end up displaying on the screen a waveform that in no way represents the signal you are trying to measure.



3. Use the LeCroy scope to manually perform some measurements on the signal using the vertical and horizontal

cursors.

a.

b.

c.
d.

Go to the Cursors = Horizontal(Time) menu to turn on the horizontal cursors. Note that the cursor value
will be displayed in the lower right-hand corner and lower left-hand corner of the scope screen.

Use the CURSORS knobs to measure the period and frequency of the sinusoid and record them in the
table below.

Go to the Cursors = Vertical(Amplitude) menu to turn on the vertical cursors.

Use the CURSORS knobs to measure the peak amplitude, peak-to-peak amplitude, maximum, and
minimum values of the sinusoid and record them in Table 1.

4. Use the LeCroy scope to automatically perform some measurements on the signal using the Measure functions.

Go to the Measure - Measure Setup menu to bring up the built-in measurement functions.

The scope will allow you to display up to six different waveform measurements, labeled “P1” through
“P6”. At the moment, they should all say “None”

Select measurement “P1”, which should bring up a menu of the possible operations. Scroll down until
you see “Period”, and then select it. Note that the scope will then compute and display the measurement
on the screen under the waveform, along with a green check-mark. The green check-mark means that the
scope believes the measurement to be good quality and valid data; a red x-mark means that the
measurement is of poor quality and possibly invalid.

Repeat steps b and ¢ and setup P2-P6 to measure: Frequency, Maximum, Minimum, Average, and Peak-
to-Peak amplitude. Record the scope automated measured values in Table 1.

5. Use the LeCroy scope to display the frequency spectrum of the signal using the Math functions.

a.

b.

File

On the Oscope select Math— Math Setup. Set the operator to FFT Magnitude, and verify that the FFT is
operating on the channel that contains your signal. Then check the “Trace On” box.

As we have seen before, the FFT computes frequency content from 0 Hz to fy/2 Hz, where f, is the sample
frequency. This means that the left end of the display is set for 0 Hz, and the right end is set for fy/2 Hz.
The current sample frequency is shown on lower right corner under “Timebase”, in units of Sa/s (which
means samples/sec). Because the sampling frequency is likely 5.0 GHz, your frequency spectrum likely
appears as a big orange blob.

Select Channel 1 by selecting the C1 tab. Adust the HORIZONTAL timebase knob until the sampling
frequency (which is displayed under the “Timebase” block in the lower right-hand corner of the screen)
displays a rate of 10 MS/s, or a timebase of 10.0p sec/div.

Next, set the scope to record exactly 1,000 samples of the waveform by selecting Timebase = Max
Sample Points = 1.0 ks. You may have to readjust the timebase knob to get back to 10 MS/s.

Use the Horizontal cursors to measure the frequency of your sinusoid and verify that it matches the time-
domain measurement. When finished, your screen should look like the following:
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Figure 4: LeCroy Oscilloscope screen when properly set up and configured to perform spectrum measurements.



6. Save the LeCroy scope data in a format that can be used by Matlab.
Note: The Low-Capacity External USB Hard Drives ITSD requires us to use can be found on the instructor’s desk.

a. Save the time-domain waveform by going to the File > Save Waveform menu and making sure the
following options are selected:
i. Save To: File
ii. Source: C1
iii. Format: Matlab
iv. Autosave: Off
b. Give the trace a meaningful title, and press the Save Now button.
c. Save the frequency spectrum by going to the File > Save Waveform menu and making sure the following
options are selected:
i. Save To: File
ii. Source: Math
iii. Format: Matlab
iv. Autosave: Off
d. Give the trace a meaningful title, and press the Save Now button.

Table 1: Theoretical and Measured Characteristics of the 1.1 MHz Sinusoid

Theoretical LeCroy LeCroy

Parameter Cursor Automated Matlab
Value Measurement
Measurement Measurement

Minimum

Maximum

Amplitude
Peak-to-Peak
DC Offset

Period

Frequency

How do the two LeCroy measured values compare with the theoretical values? What is the average percent difference
between the measured values and the theoretical values?




Part 4: Comparison of the Theoretical and Measured Sinusoidal Signals

To load the saved oscilloscope data into Matlab (for further analysis or plotting), first copy the wave data from the external
hard drive into Matlab’s current working directory.

Next, Issue the following commands (I highly recommend writing a function that does this, as you will be performing the
following operations repeatedly throughout the course):

First, start with your time-domain sinusoid.

» load(“Ffilename.dat”); % Loads waveform data, replace “filename.dat” with
» % the name of your time-domain file.
»time = Filename(:,1); % The time axis (in sec) is stored in the first col.

X

»amp = Filename (:,2); o Amplitude info (in V) is stored in the second col.

Next, plot the waveform and adjust the axes (see the sections above for instructions) to show a few cycles of the sinusoid.
Use the Matlab commands min, max, and mean, to fill in the time-domain measurement values for Table 1 (we’ll get to
the frequency and period measurements in a moment).

Once you are satisfied that your captured signal was successfully loaded into Matlab, generate a single plot that shows both
the theoretical signal as well as the scope captured signal on the same plot. Use a different identifying feature (whether line
style, line width, or line color) to differentiate the two signals. You can type “help plot” if you need to refresh your
memory. Add a legend to your plot to clearly identify the two signals (type “help legend” if you need to refresh your
memory). Don’t forget to add meaningful axes labels and titles. When finished, your plot should look similar to the
following (note that phase offsets will prevent the two signals from exactly lining up).
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Figure 5: Example comparison of the Theoretical and LeCroy Oscilloscope Captured Sinusoids

Printout a copy of your plot and turn it in with the completed lab.

How closely does the time-domain sinusoid captured from the oscilloscope match the theoretical sinusoid? What, if
anything, causes the differences?




Next, we’ll observe the frequency spectrum as captured by the scope and compare it with the theoretical spectrum. Use the
following Matlab commands to load the FFT capture into your Matlab workspace.

» load(“Ffilename.dat”); % Loads waveform data, replace “filename.dat” with

» % the name of your frequency-domain file.

» freq = Filename(:,1); % The frequency axis (in Hz) is stored in the first col.
»pwr = Filename (:,2); ¢ Amplitude info (in dB!) is stored in the second col.

X

Next, plot the waveform and adjust the axes (see the sections above for instructions) to show the frequency spectrum of the
signal. Once you are satisfied that your signal was successfully loaded into Matlab, use the following series of commands
to plot both the theoretical spectrum and scope-captured spectrum on the same figure.

» Figure % Sets up the figure

» subplot(2,1,1) . )

» periodogram(sl,[], “onesided®,N,fs): % Plot 1_:he theoretical spectrum and set the
»axis([0 5 -100 10]) h o axis

» subplot(2,1,2)

% Plot the measured spectrum and set the

» plot(freq,pwr, "k-", " linewidth",2) % axis.

»axis([0 5 -100 10])

»

Use the Matlab command max and/or the Figure Data Cursor e (the button on the Matlab figure) to determine
the frequency and period of the captured spectrum, and record these values in Table 1. When finished, your figure should
look something like the one below:
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Figure 6: Comparison of the theoretical and LeCroy Oscilloscope captured spectra of the sinusoidal signal.
Printout a copy of your plot and turn it in with the completed lab.

How closely does the frequency spectrum of the sinusoid captured from the oscilloscope match the theoretical spectrum?
What, if anything, causes the differences?




Part 5: Hardware Measurements of the Sinusoidal Signal via the Spectrum Analyzer

The quick reference guide for the Anritsu Spectrum Analyzer is posted on the main EE354 website. Before proceeding,
download a copy of the quick reference guide and open it in a new window to use as a reference for operating the
oscilloscope.

Disconnect the Agilent 33220A Function Generator from the Oscilloscope and connect it to the input of one of the Anritsu
MS2711D spectrum analyzers, as shown in the figure below. Also, connect the Anritsu to the PC using the RS-232 cable at
the lab bench.

NOTE: The very first thing that will likely happen is that the spectrum analyzer will produce an “OVER RANGE!
Increase Attenuation” warning on the screen. We shall deal with that momentarily.
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Figure 7: Agilent Signal Generator to Anritsu Spectrum Analyzer Connection.
For reference, Figure 2-2 from the quick reference guide is provided in Figure 8.
1. Adjust the spectrum analyzer to get rid of the Over Range Warning

a. Press the AMPLITUDE function hard key, select the Ref Level soft key, enter “10” on the numeric
keypad, and then press ENTER. At this point the “OVERRANGE” warning should go away.

2. Configure the spectrum analyzer to display the spectrum of our sinusoid. The spectrum analyzer will display a 3.0
GHz range of frequencies, which is too large to view the 1.5 MHz sinusoid, so we need to adjust the frequency
range. You may also notice an

a. Power on the spectrum analyzer and return it to the default configuration by pressing Recall Setup (which
is keypad hard key “6”), use the up/down arrow keys to select “0 --- <Default>", and then press Enter.

b. Press the FREQ/SPAN function hard key, then select the Start soft key, enter “0.75” on the numeric
keypad, and then press the MHz soft key.

c. Select the Stop tab, enter “1.25” on the numeric keypad, and then press the MHz soft key.

d. At this point, something approximating the spectrum of the sinusoid should appear on the screen.
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Figure 8: The MS2711D Instrument Overview

Note: The Frequency Start, Stop, and Reference Level (Ref Level) values control how the signal spectrum is displayed on
the screen, much like the horizontal and vertical time scales control how the time-domain signal is displayed on the
oscilloscope. The Reference Level represents the maximum signal power level (in dBm, which we will learn about
shortly), at the very top of the screen. If you adjust the Reference Level, you should be able to move the spectrum up and
down on the screen (try it by selecting “20” or “-20” and see what happens). The Frequency Start and Stop control how
much of the spectrum is shown on the screen. Setting these too wide will obscure very important features of your signal,
setting these too narrow will cause a complex spectrum to look like a single sinusoid. Try setting the stop frequency to 100
MHz, then 1.0 GHz and observe what happens to the displayed signal spectrum.

3. Use the spectrum analyzer markers to measure and verify the frequency of the sinusoidal signal. The Anritsu has

four (4) independent markers which can be turned on or off individually.

a. Press the Marker (which is keypad hard key “8”) button, select the M1 soft key, and toggle the On/Off
soft key until the marker is turned on.

b. The marker will likely appear as a red line to the left- or right-hand side of the screen. Use the up/down
arrow keys to move the marker until it is centered on the peak of the sinusoid. You may find it useful to
adjust the frequency range of the spectrum analyzer to zoom in on the sinusoid. The marker frequency
and amplitude are displayed in the lower left-hand corner of the Anritsu screen (the “message area”)
under the “M1” label.

c. Verify that you have the peak value by pressing the Marker to Peak soft key.

d. Record the amplitude and frequency of the Marker in below.

Frequency: Power Level:
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4,

Now, transfer the spectrum analyzer plot to the PC using the following steps.

a. Onthe PC, select Start - Anritsu > Handheld Software Tools v6.61
b. On the Menu Bar, select Capture - Capture Current Plot to Screen as shown below

m Handheld Software Tools
File Edt Wiew Capture Tools Setkings  ‘Window Help

=~ Capture Plots to Screen -
i‘_‘_‘ 4 Capture Flots ko dat files 3 ?
Capture Ploks to Database

Capture Current Plot to Screen F2

c. After the program established communication with the spectrum analyzer, your screen should display a
replica of what’s currently displayed on the spectrum analyzer.

d. Note that Marker 1 is currently displayed on the screen. You can use the mouse to move the marker
around, and you can add any of the M2-M6 markers if you need to make additional measurements. Your
completed spectrum should look like the one shown below.
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Figure 9: The Sinusoidal Signal Spectrum as recorded by the MS2711D Spectrum Analyzer.

Printout a copy of your spectrum and turn it in with the completed lab.

5.

Now, we’re going to explore one final feature of the spectrum analyzer: how the Span and Resolution bandwidth
impacts the way the spectrum is displayed on the screen. We haven’t (yet) described AM Modulation, but at this
point, all you need to know is that the signal you’re about to create will have a spectrum that contains three distinct
peaks, one at 1.1 MHz, one at 1.101 MHz, and one at 1.099 MHz.

a.  On the Agilent Function Generator, press the Mod button, toggle the Type tab until it reads “AM”, toggle
the Source tab until it reads “Internal”, then press the AM Depth tab and set it to 75%.

b. Next, select the AM Freq tab and set it to 1.0 kHz, and toggle the Shape tab until it reads “Sine”.

¢. You will probably not notice any meaningful change in the spectrum analyzer’s display, because the span
is set too large to actually see the waveform. We need to zoom in on the signal in order to differentiate
the peaks.

d. On the spectrum analyzer, first, press the FREQ/SPAN hard key, select the Center soft key, enter “1.1” on
the numeric keypad, and then press the MHz soft key.

e. Select the Span soft key, enter “10” on the numeric keypad, and then press the kHz soft key.

f. At this point, you will likely see all three peaks on the screen, with the 1.1 MHz in the center of the
screen, and each of the other peaks one horizontal division to the right or left. What we have done is
center the spectrum analyzer around our frequency of interest, and set the screen to show a total span of
10 kHz (i.e., 1.0 kHz per horizontal division). Change the span and observe how you can zoom in or out
on your signal of interest.
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g. The last feature of the spectrum analyzer that will be explored in this lab is the Resolution Bandwidth.
The spectrum analyzer operates by sweeping across the frequency range set on the screen and measuring
the power level at a given point in that range. The spectrum analyzer, however, does not have infinitely
fine resolution, and its ability to show distinct components is set by the Resolution bandwidth. Signals
that fall within the Resolution bandwidth will be displayed as a single frequency, potentially giving the
viewer inaccurate results.

h. Press the BW/Sweep hard key, followed by the Bandwidth soft key, then the RBW Manual soft key. Use
the Up/Down arrow keys to change the value to 1.0 kHz, and then press ENTER.

i.  On the screen, you’ll notice that your waveform has been resolve as a single, large blob of spectrum (you
may see some “lumpiness” that looks like the two side signals). This is because the Resolution
Bandwidth is set too large to effectively show the two side signals.

j. Using the procedure above, change the Resolution Bandwidth several different values and observe the
effect on your signal. When finished, reset the Resolution Bandwidth to “Auto” (BW/Sweep—>
Bandwidth-> RBW Auto).

k. Use the markers to measure the frequency and power levels associated with the three signals on the
screen and record the values below.

Frequency Power Level

Printout a copy of your spectrum and turn it in with the completed lab.

Items to Turn In

Completed Lab

Matlab Code

Plot of the Matlab generated time-domain version of a single sinusoid

Plot of the Matlab generated frequency spectrum of a single sinusoid

Plot of the comparison between the simulated and scope-captured time-domain signal.
Plot of the comparison between the simulated and scope-captured spectrum.

Printout of the Anritsu captured spectrum of the single sinusoid

Printout of the Anritsu captured spectrum of the AM signal.
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